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Введение

BARS Gateway является сетевым шлюзом и позволяет устанавливать защищенные(с аутентификацией и шифрованием потока данных) каналы между несколькими хостами. Базовым протоколом является TCP/IP. Соответственно, шлюз можно применять в любых системах, использующих в качестве транспорта протокол TCP/IP.


Ниже представлена основная модель встраивания шлюза BARS Gateway.
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Как показано на рисунке, между серверным шлюзом и несколькими клиентскими шлюзами весь поток данных шифруется. Тип шлюза, а также другие параметры(настройки системы протоколирования, системы безопасности, сетевые настройки, опции мостовTopic30) задаются с помощью конфигурационного файлаTopic3>main.


Шлюз BARS Gateway поддерживает несколько типов криптографических библиотек. Но в каждой конкретной инсталяции работает только одна. Данная версия работает с библиотеками стандарта GSS (General Security Service).


Криптошлюз также позволяет осуществлять мониторинг клиентов в окне Client ManagerClient Manager>main, что включает в себя следующую информацию: уникальный идентификатор клиента, имя клиента, его адрес в описании соединения, статистику по входящим/исходящим данным и статус (активный/приостановленный) клиента. Здесь же можно управлять клиентскими соединениями: приостановить выполнение выбранных клиентов, восстановить выполнение, прервать выполнение клиентов.


Система ведет лог(протокол) сеанса работы. Протокол пишется паралельно в файл на диске и в окна клиентского интерфейса. Для удобства предлагается 4 вида протокола: полный(в окне Full LogFull Log>main), сообщения об ошибках(в окне ErrorsTopic13>main), предупреждающие сообщения(в окне WarningsTopic14>main) и трассовыe или отладочные сообщения(в окне DebugTopic15>main). Все типы сообщений делятся на группы, в зависимости от типа(сообщения от криптографической библиотеки, сообщения транспортного уровня, системные сообщения и прочие). Описание групп сообщений см. вTopic16Topic16>main Группы сообщенийTopic16>main.


Дополнительно система протоколирования поддерживает подключаемые модулиTopic20. Они представляют собой динамически загружаемые библиотеки (DLL), экспортирующие ряд функций. Такие модули должны реализовать интерфейсTopic28 подключаемых модулей протоколирования.


В процессе инсталяции создается специальный ключ реестра HKEY_LOCAL_MACHINE\SOFTWARE\UnityBars\Gateway, внутри которого присутствуют два строковых параметра:

Path - путь к исполняемому модулю barsgtw.exe.

Config - путь к конфигурационному файлу gateway.xml.

Программы, работающие со шлюзом с помощью API управленияTopic25 могут использовать эти ключи при необходимости.
Описание изменений версий (Release Notes)

Данный раздел содержит информацию об изменениях, сделанных в версиях шлюза BARS Gateway.

Версия:  2.3.1    дата выхода: 26.01.2010

Исправлена ошибка внесенная в версии 2.2.9. Проявлялась только при выключенном шифровании в виде зацикливания шлюза и поедания ресурсов процессора.

Версия:  2.3.0    дата выхода: 03.11.2009
Шлюз собран под MS VC++ 2005. Используется новый CORBA-брокер версии 2.3.13.
Версия:  2.2.10    дата выхода: 18.07.2009
Модифицирован основной цикл обмена сообщениями для нивелирования влияния параметра /Gateway/WaitTimeout. Рекомендованное значение данного параметра 2 секунды. Имена объектов межпроцессной синхронизации содержат путь к файлу конфигурации в верхнем регистре(раньше в исходном виде), чтобы избежать ошибок при запуске шлюза с одним и тем же конфиг-файлом, но в разном регистре. Перекомпилированы библиотеки seclogin.dll, odbclogin.dll, purelogin.dll с номером версии 2.2.10. В данных библиотеках добавлена инициализация внутренней переменной CORBAHost умолчательным значением ”127.0.0.1”. При использовании библиотек вначале обязательно  вызывать ф-цию SetParams() или SetParams2(). Для корректной работы со шлюзом версии 2.2.10 пересобраны модули gatestart.exe, gatedown.exe, gatelog.exe.
Версия:  2.2.9    дата выхода: 07.03.2009
В конфигурационный файл добавлен необязательный параметр 
/Gateway/CORBA/Host – хост CORBA сервера.
Файл новой схемы – gateway.229.xsd должен присутствовать в директории “config”.
По-умолчанию, если параметр не задан, он имеет значение “127.0.0.1”. Для прослушивания CORBA-сервером внешнего порта необходимо задать значение “0.0.0.0” или один из IP-адресов хоста.
Для удаленного подключения к CORBA-серверу(из клиентского приложения или веб-сервера) необходимо использовать библиотеку purelogin.dll версии не ниже 2.2.9. В данной библиотеке введена новая функция SetParams2(), отличающаяся от SetParams() наличием параметра szCORBAHost. Детально см. раздел “API управления клиентским шлюзом”.
Версия:  2.2.8    дата выхода: 18.01.2009
- Изменен алгоритм работы основного цикла шлюза. При временно заблокированном на запись сокете разрешаем чтение из него для разгрузки внутреннего буфера (возможно переполненного).
- Для предотвращения бесконечного зацикливания при попытке послать данные в заблокированный на запись сокет(в процессе аутентификации или пересылки исключения другому шлюзу) выдается следующая ошибка:

ERR: Сокет недоступен для записи(передачи) больше 200 000 раз подряд

Время ожидания такого сообщения 3-5 минут.
- В утилите BARS Gateway Configurator требование включать защиту протокола контрольной суммой остается только если путь к криптографической библиотеке не указан вообще или указан к библиотеке NGSec.dll.

Версия:  2.2.7    дата выхода: 19.11.2008
- Внесены изменения для поддержки библиотеки vega2gss.dll(GSS-оболочка для vega32.dll).

Для использования библиотеки vega2gss.dll дополнительно нужны VegaCCP.dll, vegamsg.dll, vega32.dll. В случае работы с sToken нужны соответствующие драйвера и библиотеки.
Версия:  2.2.6    дата выхода: 25.03.2008
- Изменен алгоритм вычитывания полного пакета с использованием ожидания следующей порции данных. Ранее применялся цикл, что на плохих сетях приводило к сильной загрузке процессора. 
Требуется новый файл схемы gateway.226.xsd.
В новой схеме введен параметр

/Gateway/PacketReadTimeout - время ожидания чтения полного пакета данных в сек (default: 60 sec)

При редактировании xml-файла конфигурации необходимо указать новую схему в атрибуте xsi:noNamespaceSchemaLocation.
Версия:  2.2.5    дата выхода: 15.02.2008

- Версия с дополнительной отладочной информацией для работы шлюза в паре с веб-сервером при большой загрузке на плохих сетях.
Версия:  2.2.4    дата выхода: 11.09.2007
- Реализована возможность задания пути реестра в параметре Library.Path (/Gateway/Library/Path) конфигурационного файла. Для указания того, что задаваемое значение является путем реестра необходимо добавлять префикс REG:, например:

REG:\HKEY_LOCAL_MACHINE\SOFTWARE\UnityBars\Web\Sign\SL2\Sl2gss
REG:\HKEY_LOCAL_MACHINE\SOFTWARE\NBU\NbuSecurity\LibPath
По данному ключу должен находиться физический путь к библиотеке защиты.

Если префикс REG: не указан, но параметр заполнен, значение считается прямым физическим путем к библиотеке защиты. Если же параметр не заполнен, то для совместимости путь к библиотеке защиты читается из ключа реестра HKEY_LOCAL_MACHINE\SOFTWARE\NBU\NbuSecurity\LibPath.
Версия:  2.2.3    дата выхода: 27.04.2007

- Реализована возможность запуска нескольких процессов шлюза на одной машине. Ключем является путь к конфигурационному файлу. В строку-подсказку (tooltip) для иконки в системном трее(в правом нижнем углу экрана) добавлена строка, указывающая путь к конфигурационному файлу. Соответственно модифицированы библиотеки seclogin.dll, odbclogin.dll и purelogin.dll. Также переписаны утилиты gatestart.exe и gatedown.exe для запуска и останова шлюза. Gatedown.exe теперь требует задания пути конфигурационного файла останавливаемого шлюза. Детально см. gatedown /?.
  При запуске на одной машине двух и более экземпляров шлюза, необходимо задавать различные значения для конфликтующих параметров:

1. /Gateway/Logger/File – путь к файлу протокола.

2. /Gateway/CORBA/Port – порт CORBA сервера.

3. /Gateway/CORBA/IORProviderPort – порт поставщика IOR-ссылки.

4. /Gateway/CORBA/Dir – директория CORBA сервера(только если включены параметры /Gateway/CORBA/ServerLog или /Gateway/CORBA/DumpIOR).
5. Пары /Gateway/Bridges/Bridge/Listener/Host и /Gateway/Bridges/Bridge/Listener/Port – хост и порт слушателя мостов.
- Определение MAC-адреса клиента при соединении переписано с использованием функции SendARP(…) (ARP – Address Resolution Protocol). Раньше MAC-адрес определялся через NetBIOS, что приводило к большим задержкам, если данный протокол был отключен.
Версия:  2.2.2    дата выхода: 10.05.2005

- При разборе XML-файла настройки шлюз пытается инстанцировать парсер MSXML 4.0. Если такой в системе не зарегистрирован, инстанцирует MSXML 3.0. В случае использования парсера 3-ей версии XML-файл настройки не валидируется на соответствие схеме.

- Введена новая версия схемы файла настройки: gateway.222.xsd

Совместимость сохранена, т.е. шлюз продолжает работать со схемой gateway.xsd, если файл настройки соответствует ей. При этом значения новых параметров, введенных в новой схеме, устанавливаются в умолчательные.

В схеме gateway.222.xsd введен параметр /Gateway/CORBA/IORProviderPort - порт поставщика IOR-ссылки CORBA-сервера. Умолчательное значение 7700. Поставщик  IOR-ссылки - это внутренний TCP-сервер, единственным назначением которого является передача IOR-ссылки по запросу.

Для работы с новой схемой требуется BARS Gateway Configurator версии 2.2.2.

- В библиотеки API шлюза добавлены функции SetTraceMode(), GetTraceMode(), SetTraceFile() для управления режимом вывода сообщений и трассировкой в файл или на экран в виде диалогов и задания файла трассировки. В функциях CreateBridge и ResolveConnection параметры портов имеют тип unsigned short. Детально см. API управления клиентским шлюзомTopic29.

- В синхронизаторе исправлен вывод статистики (при подсчете были перепутаны Обновление с Удалением).

- Изменена идеология работы с функцией ResolveConnection. Детально см. Определение ключа соединенияTopic33.

- Реализована утилита BARS Gateway MonitorTopic34 для мониторинга серверного шлюза и управления соединениями.

Версия:  2.2.1    дата выхода: 06.04.2005

- Расширено чистое API шлюза(без привязки к СУБД) (библиотекa purelogin.dll). Добавлена функция ResolveConnection(...) для определения идентификатора ключа соединения по его IP-адресу и номеру порта для дальнейшей авторизации пользователя. Детально см. API управления клиентским шлюзомTopic25.

Версия:  2.2.0    дата выхода: 29.03.2005

- Ядро шлюза портировано на платформу Intel Itanium 64 bit под OS Windows 2003 Server. 

- Разбор файла настройки переписан с использованием MSXML 3.0. Раньше использовался парсер MSXML 4.0. Из инсталяции убран парсер MSXML 4.0.

Версия:  2.1.1    дата выхода: 04.03.2005

- Включено автоматическое обновление окна Client Manager для клиентской версии шлюза. Для сервера необходимо обновлять окно вручную.

- Унифицирован формат многострочных сообщений об ошибках. Первое сообщение идет на следующей строке для лучшей читабельности. Длинные сообщение(больше 255 символов) также разбиваются на строки.

Версия:  2.1.0    дата выхода: 20.01.2005

- Шлюз собран на MS VC++ 7.1. Как следствие требуются новые библиотеки времени выполнения msvcp71.dll, msvcr71.dll а также библиотека mfc71.dll. 

- CORBA Broker заменен на версию 2.3.11, которая реализована в библиотеке mico2311.dll.

- Клиентская библиотека seclogin.dll переписана с использованием ORACLE OCI через oci.dll. Paньше использовался препроцессор Pro*C/C++ что приводило к проблемам при запуске на младших версиях клиента ORACLE (младше 9.2).

Версия:  2.0.8    дата выхода: 11.01.2005

- В программе установки(инсталяции) модифицирована форма запроса на создаваемые ярлыки. Запрашиваемые опции описаны более подробно.

- В программе BARS Gateway Configurator сделаны следующие изменения:

при сохранении выполняется контроль на совместимость параметров аутентификации и шифрования; программа корректно работает в видеорежиме 800x600.

- Детализирована проверка на корректность параметров конфигурационного файла при старте шлюза.

- Реализована проверка параметров шифрования на клиенте и сервере во время выполнения аутентификации. В случае расхождения сервер возвращает клиенту соответствующее сообщение и разрывает соединение с данным клиентом.

- В библиотеках seclogin.dll и odbclogin.dll реализована загрузка библиотеки NGSec.dll по ключу реестра \\HKEY_LOCAL_MACHINE\SOFTWARE\NBU\NbuSecurity\LibPath.

- В протокол шлюза реализована запись предупреждений системы безопасности(н-р, в случае изменения порядка пакетов).

- Реализована запись в протокол абсолютного пути самого файла протокола. Реализована запись пометок (default) для всех параметров из конфигурационного файла, заданных по-умолчанию.

- Реализована корректная расшифровка кодов ошибок при проверке целостности протокола и запись в протокол имени поврежденного файла перед началом ведения нового протокола.

- В документации добавлен раздел по конфигурированию и использованию модулей протоколирования popup.dll и netsend.dll.

Описание меню

File

	Full Log
	показать/скрыть окно Full LogClient Manager.

	Errors
	показать/скрыть окно ErrorsTopic13.

	Warnings
	показать/скрыть окно WarningsTopic14.

	Debug
	показать/скрыть окно DebugTopic15.

	Client Manager
	показать/скрыть окно Client ManagerClient Manager.

	Exit
	завершить работу.


View

	Toolbar
	показать/скрыть панель инструментов.

	Status Bar
	показать/скрыть панель статуса.


Options

	Beeper
	включить/выключить звуковой сигнал при ошибках и предупреждениях.

	Hide When Minimized
	прятать окно при минимизации размера.


Manager

	Resume Client
	возобновить работу выбранных клиентов(статус Active). 

	Suspend Client
	приостановить работу выбранных клиентов(статус Suspended).

	Terminate Client
	завершить работу выбранных клиентов.

	Terminate All Clients
	завершить работу всех клиентов.

	Refresh Manager
	обновить содержимое окна Client ManagerClient Manager.


Window

	Cascade
	расположить окна каскадом.

	Tile Horizontally
	расположить окна горизонтальной черепицей.

	Tile Vertically
	расположить окна вертикальной черепицей.

	Arrange Icons
	расположить окна в порядке следования.


Help

	Contents
	показать содержимое помощи.

	About BARS Gateway...
	информация о шлюзе BARS Gateway, его версии и авторских правах.


Концепция моста

В версии 2 шлюза BARS Gateway введено ключевое понятие моста. Мост - это абстракция для инкапсуляции понятий TCP-маршрута прохождения соединения, его параметров безопасности и параметров брандмауэра. Ниже представлена модульная схема моста:
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Firewall - суть брандмауэр. Состоит из набора запрещающих и разрешающих правил. Запрещающие правила имеею наивысший приоритет, т.е. если входящее соединение соответствует одному из запрещающих правил, оно мгновенно отбивается. Разрешающие соединения дают возможность указать допустимые параметры соединения. В случае, если при наличии правил брандмауэра не встретилось ни одного разрешающего, соединение также отбивается. При полном отсутствии привил брандмауэр считается выключенным. Опции брандмауэра состоят из:

	Действие
	accept - принять, reject - отвергнуть.

	Удостоверение или маска
	ID или маска ключа, который надо принять/отвергнуть.

	Имя хоста или маска
	Имя хоста или маска с которого надо принять/отвергнуть соединение.


По вопросам настройки брандмауэра см. Конфигурирование шлюзаTopic3.


Listener - абстракция TCP-слушателя с возможностью аутентификации соединения и шифрования трафика. Позволяет указать имя или адрес прослушиваемого хоста (для клиента важно прослушивать только localhost, для сервера необходимо прослушивать внешний адрес), номер прослушиваемого порта, идентификатор ключа, с помощью которого будет проводиться аутентификация и шифрование, и, собственно, сами флаги аутентификации и шифрования трафика.


По вопросам настройки TCP-слушателя см. Конфигурирование шлюзаTopic3.


Remote - абстракция параметров удаленного сервера. Это может быть как сервер БД или сервер приложений для серверного шлюза, так и удаленный серверный шлюз для клиентского шлюза. Удаленные сервер параметризуется с помощью имени или адреса хоста, номера порта, идентификатора ключа (необходимо указывать только для клиентского шлюза) и флагов аутентификации и шифрования (только для клиентского шлюза).


По вопросам настройки удаленного сервера см. Конфигурирование шлюзаTopic3.

Конфигурирование шлюза с помощью BARS Gateway Configurator

Сетевой шлюз BARS Gateway необходимо запускать с одним параметром - именем конфигурационного файла. Например:


barsgtw.exe gateway.xml


В случае сервиса Windows при регистрации необходимо указывать полный путь к конфигурационному файлу. 


При запуске шлюза без параметров он пытается читать файл gateway.xml из текущей директории.


Конфигурационный файл сохраняется в XML формате в unicode-кодировке UTF-8. Схема данного файла обязательно должна быть в файле с именем gateway.xsd и находиться в одной директории с конфигурационным файлом. В дистрибутиве шлюза файл gateway.xsd находится в директории config.

Редактировать конфигурационный файл можно как вручную, с помощью любого текстового редактора, поддерживающего кодировку UTF-8, так и с помощью специальной программы BARS Gateway Configurator. Для функционирования BARS Gateway Configurator требуется наличие на машине JRE (Java Runtime Environment) версии 1.3.1 или выше (рекомендуется версия 1.4.2). Также строго рекомендуется устанавливать JRE в директории без пробелов. При этом сам конфигуратор может быть установлен в директории с пробелами.

Приведем описание интерфейса и принципов работы BARS Gateway Configurator. Общий вид программы следующий:
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Краткое описание меню программы:

	File->New
	Создать новый конфигурационный файл.

	File->Open
	Открыть существующий конфигурационный файл.

	File->Save
	Сохранить редактируемый конфигурационный файл.

	File->Save as
	Сохранить редактируемый конфигурационный файл с новым именем.

	File->Exit
	Завершить работу с программой.


	Help->Configurator Help
	Помощь по программе.

	Help->About
	Информация о программе.


Краткое описание закладки "Основные параметры":

	Наименование шлюза
	Укажите мнемоническое наименование шлюза. Обязательный параметр.

	Тип шлюза
	CLIENT/SERVER. По-умолчанию CLIENT. Для промежуточных шлюзов используйте тип SERVER. Тип шлюза дает возможность разграничить права на управление с помощью клиентского API и мониторинг серверного шлюза.

	Тип крипт. библиотеки
	GSS/CIPHER/SSL/WIN. По-умолчанию GSS(General Security Service).

	Путь к крипт. библиотеке
	Необязательный параметр. Если не указан, для типа GSS реализации НБУ делается попытка прочитать путь из ключа реестра HKEY_LOCAL_MACHINE\SOFTWARE\NBU\NbuSecurity\LibPath.

	Время ожидания данных
	Время в секундах ожидания данных по сети. Необязательный параметр. По-умолчанию 2 секунды. Этот параметр влияет только на время реакции шлюза при завершении работы.

	Задержка при аутентиф.
	Время в секундах ожидания порции данных при аутентификации. Необязательный параметр. По-умолчанию 20 секунд.

	Разрыв соединения
	Тип разрыва соединения: 1-сторонний/2-сторонний. Сейчас следует использовать 1-сторонний.

	Рассылка сигналов для определения рабочих соединений
	При включенной опции шлюз рассылает специальные сигналы для определений рабочих соединений. Включать необходимо только на серверном шлюзе.


Настройки параметров протоколирования работы шлюза осуществляются на закладке "Параметры протокола"
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Краткое описание закладки "Параметры протокола":

	Путь к файлу протокола
	Обязательный параметр. Желательно указать полный путь к файлу.

	Уровень детализации протокола
	Порог для вывода сообщений в протокол. Может принимать значения:
ALWAYS - самые критические сообщения,
ERROR - только сообщения типа ошибок и самые критические,
HIGHEST - сообщения очень высокого приоритета,
HIGH - сообщения высокого приоритета,
RECENT - важные сообщения о работе шлюза,
COMMIT - сообщения о начале и завершении какой-либо работы,
VERBOSE - детальные сообщения о работе шлюза,
DEBUG - отладочные сообщения.
Сообщения об исключительных ситуациях и критических ошибках, в свою очередь, делятся на группыTopic16.

	Вывод протокола в окна интерфейса
	Флаг вывода протокола в окна интерфейса. Используется только на клиенте.

	Защита протокола контрольной суммой
	Флаг защиты каждой строчки протокола контрольной суммой. При включенной опции также проверятся целостность файла протокола на старте шлюза. 

	Протокол ограниченного размера
	Флаг ведение протокола ограниченного размера.

	Максимальный размер файла протокола
	Максимальный размер файла протокола, представленный в формате: NnnT, где Nnn-число-размер файла, T-тип размера: M-мегабайт, K-килобайт, отсутствует-байт. Н-р: 1024, 64K, 4M

	Количество архивных файлов протокола
	Число. Количество файлов архивных копий протокола.

	Наименование модуля
	Мнемоническое имя подключаемого модуля протоколирования. Для навигации по списку имен используйте прокрутку таблицы. Для добавления, удаления, удаления всех имен модулей используйте кнопки +, -, --.

	Путь к модулю протоколирования
	Укажите полный путь к динамической библиотеке (DLL), реализующей данный модуль протоколирования. Библиотека должна соответствовать интерфейсуTopic20 подключаемых модулей протоколирования.

	Путь к файлу настроек подключаемого модуля
	Укажите полный путь к конфигурационному файлу данного модуля протоколирования. Необязательный параметр. Чтение этого файла при его наличии осуществляет сам модуль протоколирования. Пример см. файл netsend.xml и его схему netsend.xsd в директории config дистрибутива шлюза для модуля netsend.dll.


Краткое описание закладки "Параметры протокола":

	Путь к файлу протокола
	Обязательный параметр. Желательно указать полный путь к файлу.

	Уровень детализации протокола
	Порог для вывода сообщений в протокол. Может принимать значения:
ALWAYS - самые критические сообщения,
ERROR - только сообщения типа ошибок и самые критические,
HIGHEST - сообщения очень высокого приоритета,
HIGH - сообщения высокого приоритета,
RECENT - важные сообщения о работе шлюза,
COMMIT - сообщения о начале и завершении какой-либо работы,
VERBOSE - детальные сообщения о работе шлюза,
DEBUG - отладочные сообщения.
Сообщения об исключительных ситуациях и критических ошибках, в свою очередь, делятся на группыTopic16.

	Вывод протокола в окна интерфейса
	Флаг вывода протокола в окна интерфейса. Используется только на клиенте.

	Защита протокола контрольной суммой
	Флаг защиты каждой строчки протокола контрольной суммой. При включенной опции также проверятся целостность файла протокола на старте шлюза. 

	Протокол ограниченного размера
	Флаг ведение протокола ограниченного размера.

	Максимальный размер файла протокола
	Максимальный размер файла протокола, представленный в формате: NnnT, где Nnn-число-размер файла, T-тип размера: M-мегабайт, K-килобайт, отсутствует-байт. Н-р: 1024, 64K, 4M

	Количество архивных файлов протокола
	Число. Количество файлов архивных копий протокола.

	Наименование модуля
	Мнемоническое имя подключаемого модуля протоколирования. Для навигации по списку имен используйте прокрутку таблицы. Для добавления, удаления, удаления всех имен модулей используйте кнопки +, -, --.

	Путь к модулю протоколирования
	Укажите полный путь к динамической библиотеке (DLL), реализующей данный модуль протоколирования. Библиотека должна соответствовать интерфейсуTopic20 подключаемых модулей протоколирования.

	Путь к файлу настроек подключаемого модуля
	Укажите полный путь к конфигурационному файлу данного модуля протоколирования. Необязательный параметр. Чтение этого файла при его наличии осуществляет сам модуль протоколирования. Пример см. файл netsend.xml и его схему netsend.xsd в директории config дистрибутива шлюза для модуля netsend.dll.


Настройки параметров CORBA сервера  осуществляются на закладке "CORBA сервер". CORBA сервер служит для управления шлюзом с помощью клиентского APITopic25 на стороне клиента и для удаленного мониторинга и управления серверным шлюзомTopic26.
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Краткое описание закладки "CORBA сервер":

	Протоколирование работы CORBA сервера
	Флаг протоколирования. Протокол пишется в файл %CORBA_DIR%\corba_server.log.

	Дамп IOR-ссылки на CORBA сервер
	Флаг дампа ссылки на CORBA сервер. Пишется в файл %CORBA_DIR%\corba.ior.

	Порт поставщика IOR-ссылки
	Порт специального TCP-сервера - поставщика IOR-ссылки для CORBA сервера. По-умолчанию 7700.

	Порт CORBA сервера
	Порт сервера CORBA. По умолчанию 8888.

	Директория CORBA сервера
	Директория сервера CORBA. По умолчанию C:\BARS.


Настройки параметров мостов осуществляются на закладке "Параметры мостов". Концепция мостов предполагает наличие параметров двух обязательных частей: слушателя и удаленного сервера, и одной необязательной - брандмауэра. См.Topic30 детальное описание концепции мостаTopic30.
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Краткое описание закладки "Параметры мостов":

	Наименование моста
	Используйте имя моста для уникальной идентификации данной сущности. Допускаются произвольные имена до 256 символов. Для навигации по именам используйте средства прокрутки таблицы. Для добавления, удаления, удаления всех мостов используйте кнопки +, -, --.

	Имя хоста или IP-адрес слушателя
	Для клиентского шлюза указать localhost или 127.0.0.1. Для сервера - внешние имя или IP-адрес сервера.

	Номер порта слушателя
	Номер свободного порта для прослушивания.

	Удостоверение слушателя
	ID удостоверения ключа пользователя. Необязательный параметр.

	Флаг аутентификации слушателя
	Установить при необходимости проводить аутентификацию соединения. На клиенте не устанавливать. На сервере - рекомендуется.

	Флаг фишрования трафика слушателя
	Установить при необходимости шифрования трафика. На клиенте не устанавливать. На сервере - рекомендуется.

	Имя хоста или IP-адрес удаленного сервера
	Указать имя хоста или адрес удаленного шлюза для клиента и адрес сервера БД или сервера приложений для серверного шлюза.

	Номер порта удаленного сервера
	Указать номер порта удаленного шлюза для клиента и номер сервера БД или сервера приложений для серверного шлюза.

	Удостоверение удаленного сервера
	Указать удостоверение ключа удаленного шлюза для клиента. Оставить пустым для сервеного шлюза.

	Флаг аутентификации удаленного сервера
	Установить для клиента при необходимости аутентификации. Для сервеного шлюза не устанавливать.

	Флаг шифрования трафика удаленного сервера
	Установить для клиента при необходимости шифрования трафика. Для серверного шлюза не устанавливать.

	Действие правила брандмауэра
	accept - принять, reject - отвергнуть.

	Удостоверение или маска правила брандмауэра
	Укажите ID или маску ключа, который надо принять/отвергнуть.

	Имя хоста или маска правила брандмауэра
	Укажите имя хоста или маску с которого надо принять/отвергнуть соединение.


Мониторинг шлюза с помощью BARS Gateway Monitor

Сетевой шлюз BARS Gateway может быть запущен в виде сервиса операционной системы Windows. Это имеет свои плюсы по сравнению с запуском в виде GUI-приложения: защита от сбоев, работа в фоновом режиме без клиентской сессии ОС и т.д. При этом необходим аналог фронтального интерфейса пользователя для мониторинга у управления шлюзом аналогичный версии шлюза в виде обычного GUI-приложения. Таким инструментом выступает BARS Gateway Monitor.


Для запуска BARS Gateway Monitor служит командный файл runmon.bat.

Данный файл осуществляет вызов gatemon.bat с набором параметров:

	admin_host
	 -
	 Хост поставщика IOR-ссылки.

	admin_port
	 -
	 Порт поставщика IOR-ссылки.

	corba_host
	 -
	 Хост CORBA-сервера.

	corba_port
	 -
	 Порт CORBA-сервера.



Поставщиком IOR-ссылки является TCP-сервер в составе серверного шлюза, прослушивающий порт на локальном хосту(127.0.0.1). По-умолчанию номер порта равен 7700. CORBA-сервер предоставляет набор функций для управления шлюзом. По-умолчанию номер порта CORBA-сервера равен 9999.


В простешем случае использования BARS Gateway Monitor на одной машине со шлюзом BARS Gateway с умолчательными параметрами портов содержимое runmon.bat выглядит следующим образом:

gatemon.bat "-admin_host=127.0.0.1" "-admin_port=7700" "-corba_host=127.0.0.1" "-corba_port=9999"


Более сложная схема использования BARS Gateway Monitor предполагает удаленное подключение к шлюзу BARS Gateway. Общая схема такого подключения приведена ниже.
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На схеме Gateway Client и Gateway Server - клиентский и серверный шлюзы соответственно. IOR-bridge, CORBA-bridge - мосты для обслуживания программы мониторинга шлюза. IOR-provider - поставщик ссылки на CORBA-сервер. CORBA-сервер - сервер, предоставляющий API для управления и мониторинга шлюза. 


Настоятельно рекомендуется задавать ограничивающие правила брандмауэра для обеих мостов на стороне серверного шлюза. Таким образом можно разрешить мониторинг и управление серверным шлюзом только определенным ключам и только с определенных хостов.


При правильном задании параметров BARS Gateway Monitor загрузит основное рабочее окно:
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Функциональное назначение компонент окна:

1 - выпадающий список мостов, созданных в серверном шлюзе. Позволяет указать конкретный мост или все вместе(*).

2 - кнопка для обновления содержимого окна.

3 - переключатель режима автообновления с возможностью задания времени ожидания от 5 до 60 секунд. По-умолчанию 10 секунд.

4 - таблица активных соединений. Содержит информацию об идентификаторе соединения, ключах клиента и сервера, адреса точек соединения и входящий/исходящий трафик. Таблица может быть отсортирована по колонкам с помощью щелчка мыши по заголовку по-возрастанию значений или по-убыванию значений с нажатой клавишей SHIFT.

5 - кнопка для удаления помеченных соединений.
6 - кнопка для удаления всех соединений через выбранный мост. 
 Группы сообщений

Все сообщения в BARS Gateway разделены на простые сообщения(о принятии соединения, установлении защищенного канала и т.п.) и сообщения об исключительных ситуациях. Исключительные ситуации, в свою очередь, подразделяются на ошибки, предупреждения и отладочные сообщения.  Для исключительных ситуаций в BARS Gateway введено понятие группы. Каждая группа сообщений об исключительных ситуациях имеет свой номер. Приведем описание групп исключений.

Общие исключения.

	-1
	глобальные ошибки.

	1
	неизвестные исключения(типа "..." в C++).

	10
	стандартные исключения(типа std::exception в C++).

	100
	исключения, генерируемые шлюзом.


Исключения транспортного уровня(TCP/IP).

	110
	общие исключения функций работы с сокетами.

	111
	исключения при вызове функции connect().

	112
	исключения при вызове функции accept().

	113
	исключения при вызове функции bind().

	114
	исключения при вызове функций send()и recv().

	115
	исключения при вызове функции shutdown().

	400
	внутренний запрос на разрыв соединения.

	500
	внешний запрос на разрыв соединения.


Внутрение исключения при работе с криптографическими библиотеками.

	200
	общие исключения при криптовании.

	210
	исключения типа ошибок.

	240
	исключения типа предупреждений.

	270
	исключения типа отладочных сообщений.

	
	

	21x
	исключения типа ошибок для библиотеки x.

	24x
	исключения типа предупреждений для библиотеки x.

	27x
	исключения типа отладочных сообщений для библиотеки x.


Внешние исключения при работе с криптографическими библиотеками. Они поступают от других шюзов, которые находятся в связи со шюзом, пишущим протокол.

	300
	общие исключения при криптовании.

	310
	исключения типа ошибок.

	340
	исключения типа предупреждений.

	370
	исключения типа отладочных сообщений.

	
	

	31x
	исключения типа ошибок для библиотеки x.

	34x
	исключения типа предупреждений для библиотеки x.

	37x
	исключения типа отладочных сообщений для библиотеки x.


Каждая строка протокола имеет следующий формат.

# YYYY-MM-DD HH:mm:ss {xxx} Message

# - знак приоритетности сообщения(*- простое сообщение, ! - сообщение типа исключения).

YYYY-MM-DD HH:mm:ss - дата и время записи сообщения в протокол.

{xxx} - идентификатор клиента (уникален для одной сессии работы шлюза). Например {  9}, {124}. Таким образом, отфильтровав протокол по идентификатору, можно получить все сообщения, касающиеся только его.

Message - текст сообщения.

В окна пользовательского интерфейса(Full LogFull Log, ErrorsTopic13, WarningsTopic14, DebugTopic15) дата сообщения не пишется(только время).

В случае, когда сообщение является исключением, строка Message выглядит следующим образом.

Для исключений типа ошибки:

! [Num1/Num2] ERR: Error describe string

Для исключений типа предупреждений:

! [Num1/Num2] WARN: Warning describe string

Для исключений типа отладочных сообщений:

! [Num1/Num2] DEBUG: Debug message describe string 

где 

Num1 - номер группы исключения,

Num2 - код ошибки/предупреждения/отладочного сообщения.

Подключаемые модули протоколирования


Подключаемые модули протоколирования служат для расширения системы протоколирования шлюза BARS Gateway. С их помощью можно протоколировать работу шлюза в базе данных, рассылать критические сообщения по сети администраторам и т.д. Подключение дополнительных модулей к шлюзу осуществляется с помощью BARS Gateway Configurator.


Подключаемые модули протоколирования реализованы в виде динамических библиотек (DLL). Опционально модуль протоколирования может иметь свой файл настроек. В стандартную поставку шлюза входят два модуля протоколирования:

POPUP.DLL - выдает сообщения об ошибках в виде всплывающего модального окна. Файла настроек не требуется.

NETSEND.DLL - рассылает сообщения по сети. Данный модуль работает только под Win 2K/XP/2003. Необходимым для работы модуля является системный сервис Messenger(Служба сообщений). При этом станции-получатели могут быть как Win 9x так и Win 2K/XP/2003. Обязательным является наличие файла схемы netsend.xsd и файла настроек netsend.xml. Файл настроек имеет следующую структуру:

<?xml version="1.0" encoding="UTF-8"?>

<!--Конфигурационный файл для подключаемого модуля логгера netsend -->

<Appender xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:noNamespaceSchemaLocation="netsend.xsd">


<!-- Имя модуля -->


<Name>netsend</Name>


<!-- Префикс для сообщения, необязательный параметр -->


<Prefix>Gateway</Prefix>


<!-- Порог приоритета логгера: ALWAYS, ERROR, HIGHEST, HIGH, RECENT, COMMIT, VERBOSE, VV, DEBUG -->


<Threshold>ERROR</Threshold>


<!-- Флаг выдачи сообщений об ошибках в самом модуле при рассылке сообщений -->


<Debug>false</Debug>


<!-- Список хостов получателей сообщения через запятую: serg, den, mik -->


<Receivers>serg,den,max</Receivers>

</Appender>

Для настройки модуля необходимо отредактировать значение тега <Receivers>, указав имена машин из Вашей сети, на которые необходимо рассылать сообщения об ошибках.
Интерфейс подключаемых модулей протоколирования

Подключаемые модули протоколирования служат для расширения системы протоколирования шлюза BARS Gateway. С их помощью можно протоколировать работу шлюза в базе данных, рассылать критические сообщения по сети администраторам и т.д. Подключение дополнительных модулей к шлюзу осуществляется с помощью BARS Gateway Configurator.


Интерфейс подключаемых модулей протоколирования представляет собой набор типов функций представленный в стандартной нотации языка "C". Интерфейс состоит из двух блоков: блока констант и блока типов функций. Блок типов функций содержит описание функций возврата версии модуля, инициализации/деинициализации модуля, функции протоколирования.


Блок констант:

// спецификация импорта

#ifdef LOGAPP_EXPORTS

#
define LOGAPP_API __declspec(dllexport) 

#else

#
define LOGAPP_API __declspec(dllimport) 

#endif

// стиль вызова

#define LOGAPP_DECL
__stdcall

// определение уровней приоритета протокола

#define PRIORITY_ALWAYS

0

#define PRIORITY_ERROR


1

#define PRIORITY_HIGHEST

2

#define PRIORITY_HIGH


3

#define PRIORITY_RECENT

4

#define PRIORITY_COMMIT

5

#define PRIORITY_VERBOSE

6

#define PRIORITY_VV


7

#define PRIORITY_DEBUG


8


Блок типов функций:

/**

 * Возвращает старший номер версии модуля.

 */

LOGAPP_API int LOGAPP_DECL GetMajorVersion (void);

/**

 * Возвращает младший номер версии модуля.

 */

LOGAPP_API int LOGAPP_DECL GetMinorVersion (void);

/**

 * Инициализирует подключаемый модуль

 * @param szConfigPath [in] путь к конфигурационному файлу (необязательный параметр, может быть равен NULL)

 * @return 0 - Ok, иначе - код ошибки

 */

LOGAPP_API int LOGAPP_DECL InitAppender (const char* szConfigPath);

/**

 * Деинициализирует подключаемый модуль

 * @return 0 - Ok, иначе - код ошибки

 */

LOGAPP_API int LOGAPP_DECL DeinitAppender (void);

/**

 * Протоколирует сообщение

 * @param nPriority [in] уровень приоритета сообщения, см. константы PRIORITY_*

 * @param szMessage [in] текст сообщения

 * @return 0 - Ok, иначе - код ошибки

 */

LOGAPP_API int LOGAPP_DECL LogMessage (int nPriority, const char* szMessage);


Полный заголовочный файл см. logapp.hTopic28, в директории api, дистрибутива шлюза для разработчиков.


В дистрибутиве присутствуют модули протоколирования popup, который выбрасывает модальное окно-сообщение на все ошибки, и модуль netsend (требует конфигурационный файл netsend.xml), который рассылает сообщения по сети заданным пользователям аналогично как это делает команда net send.

Запуск шлюза в виде сервиса Windows
Версия 2 шлюза BARS Gateway может быть запущена в виде сервиса операционной системы Windows NT/2000/XP/2003. Для запуска используется исполняемый модуль gatesvc.exe, в отличии от обычного приложения, для которого используется barsgtw.exe.


Для регистрации шлюза в виде сервиса используйте командный файл install_gate_service.bat с путем к конфигурационному файлу в качестве параметра, который поставляется в дистрибутиве шлюза в директории bin. Например:

install_gate_service.bat d:\bars\config\gateway.xml

После успешной регистрации будет выдано окно с сообщением

Service 'BARS Gateway' successfully installed.


Для удаления шлюза из реестра сервисов Windows необходимо выполнить командный файл remove_gate_service.bat, который находится в дистрибутиве шлюза в директории bin. После успешного удаления будет выдано окно с сообщением

The service was successfully deleted.


Ручное управление (запуск/останов) работой шлюза осуществляется с помощью системной консоли управления сервисами Microsoft Management Console на вкладке Services. По-умолчанию сервис имеет установку автоматического старта при загрузке системы.


Сервис шлюза ведет такой же протокол работы в виде текстового файла как и обычное приложение. Кроме этого сообщения старта, завершения работы и критические ошибки пишутся в системный журнал событий Windows. Просмотреть такие сообщения можно с помощью утилиты Event Viewer.


Серверный вариант шлюза BARS Gateway рекомендуется использовать именно в виде сервиса операционной системы.

Управление клиентским шлюзом


Для управления клиентским шлюзом служит специальный APITopic29. Реализация данного API представлена библиотеками:

seclogin.dll - для работы систем на основе БД ORACLE.

odbclogin.dll - для работы систем на основе ODBC.

purelogin.dll - для работы систем с прямым взаимодействием, н-р, броузер и сервер приложений.

Общая последовательность вызовов функци API имеет вид:

[image: image9.png]SetParams()

Startup()

CreateBridge()

GetloginQ

DestroyBridge()

v

Shutdown()

Vemuonm
mapaerys cpesst

Crapmaam s

Comam woes

Tonyraces rasanse
xmossoc <5l

[

pabom

Vaaraes ocr

sepuzers paory




Ниже приведена тестовая программа на C++ по данному сценарию.

/********************************************************************


Filename
:
main.cpp


Description
:
TEST: клиентская библ. для встроенного криптошлюза


Begin

:
25-03-2002


Modified:
:   
05-08-2003






добавлено тестирование библиотеки без 






обращения к БД





25-03-2003






соединение через шлюзы с использованием ODBC






тестировано с ORACLE, Informix, Firebird(Interbase)


Copyright
:
(C) 2002-2004 UNITY-BARS Ltd.


email

:
bars@unity-bars.com.ua


dev-email
:
serg@unity-bars.com.ua

********************************************************************/

/**

 * Для работы с ORACLE предполагается, что настроен клиент

 * в БД создана таблица SEC_LOGINS,

 * которая содержит записи соответствия ключей пользователям БД 

 * создан пользователь(keykeeper) хранитель ключей, которому выдана

 * роль keykeeper_role с правом вычитки из SEC_LOGINS.

 */

/**

 * Для работы через ODBC

 * предполагается, что настроен DSN ODBC,

 * в БД создана таблица SEC_LOGINS,

 * которая содержит записи соответствия ключей пользователям БД

 */

#include <stdio.h>

#include <conio.h>

#include "../api/seclogin.h"

#include <windows.h>

#include <iostream>

using namespace std;

#define VERIFY_RESULT(_szFuncName, _res)
if(_res) { \



cerr<<"RC="<<_res<<endl; \



getch(); return -1; } else cerr<<_szFuncName<<" ... Ok"<<endl;

int main(int argc, char** argv)

{


cout<<"Start gateway client library test"<<endl;


int nRes = 0;


// путь к исп. модулю криптошлюза


char* szGatewayPath = "../bin/barsgtw.exe";


if(argc>1) szGatewayPath = argv[1];


// путь к конфиг-файлу


char* szGatewayConfig = "../config/gateway.xml";


if(argc>2) szGatewayConfig = argv[2];


// тип стартуемого модуля (приложение-START_APPLICATION, сервис-START_SERVICE)


// сервис должен быть предварительно зарегистрирован !


int
   
nStartType  
= START_APPLICATION;

#if defined(ORACLE) || defined(ODBC)


// служебная директория CORBA


const char* 
szCORBADir  
= "C:\BARS";


// порт CORBA-сервера


int         
nCORBAPort  
= 8888;


// Oracle DB Alias or ODBC Data Source


const char* 
szDBAlias   
= "GATE";


// пользователь БД - хранитель ключей


const char* 
szDBKeyUser 
= "keykeeper";


// пароль пользователя БД - хранителя ключей


const char* 
szDBKeyPwd  
= "key123456";


// роль для доступа к данным хранилища ключей2

const char* 
szDBKeyRole 
= "keykeeper_role";

#else


const char* 
szCORBADir  
= 0;


int         
nCORBAPort  
= 0;


const char* 
szDBAlias   
= 0;


const char* 
szDBKeyUser 
= 0;


const char* 
szDBKeyPwd  
= 0;


const char* 
szDBKeyRole 
= 0;

#endif


// устанавливаем рабочие параметры


nRes = SetParams (










szGatewayPath,





szGatewayConfig,





nStartType,





szCORBADir,





nCORBAPort,





szDBAlias,





szDBKeyUser,





szDBKeyPwd,





szDBKeyRole





);


VERIFY_RESULT("SetParams()", nRes);


// стартуем шлюз


nRes = Startup ();


VERIFY_RESULT("Startup()", nRes);


// ID моста (возвращается функцией CreateBridge)


int


nBridgeHandle
= 0;


// хост для прослушивания


const char*

szListenerHost  = "127.0.0.1";


// порт для прослушивания


short


nListenerPort
= 8401;


// ID ключа слушателя


const char*

szListenerID
= "I00001";


// флаг аутентификации слушателя


bool


bListenerAuth
= false;


// флаг шифрования слушателя


bool


bListenerEnc
= false;


// хост удаленного шлюза


const char*

szRemoteHost
= "localhost";


// порт удаленного шлюза


short


nRemotePort
= 8403;


// ID ключа удаленного шлюза


const char*

szRemoteID
= "I00002";


// флаг аутентификации удаленного шлюза


bool


bRemoteAuth
= true;


// флаг шифрования удаленного шлюза


bool


bRemoteEnc
= true;


// создать мост


nRes = CreateBridge (



szListenerHost,  



nListenerPort, 



szListenerID,



bListenerAuth,  



bListenerEnc,



szRemoteHost, 



nRemotePort, 



szRemoteID,



bRemoteAuth, 



bRemoteEnc,



&nBridgeHandle);


VERIFY_RESULT("CreateBridge()", nRes);

#if defined(ORACLE) || defined(ODBC)


// получаем логин и пароль БД, соответствующие данному ключу


char szDBLogin

[64];


char szDBPassword
[64];


nRes = GetLogin (



nBridgeHandle,
// [ in] handle моста



1,

// [ in] номер задачи



szDBLogin, 
// [out] имя пользователя БД



szDBPassword
// [out] пароль пользователя БД



);


VERIFY_RESULT("GetLogin()", nRes);

#endif


// здесь необходимо


// установить соединение с прикладной программы,


// используя полученные szDBLogin & szDBPassword


// .....


// здесь необходимо 


// разорвать соединение прикладной программы с сервером


// разрушить мост


nRes = DestroyBridge (nBridgeHandle);


VERIFY_RESULT("DestroyBridge()", nRes);


// завершать работу шлюза должны только системы обновления математики


// и то очень аккуратно, чтобы не срубить сук, на котором сидят


nRes = Shutdown ();


VERIFY_RESULT("Shutdown()", nRes);


cout<<"Test finished"<<endl;


return 0;

}

// указание: с какой библиотекой импорта линковать

#if defined(ORACLE)

#
pragma comment(lib, "../api/lib/seclogin.lib")

#elif defined(ODBC)

#
pragma comment(lib, "../api/lib/odbclogin.lib")

#else

#
pragma comment(lib, "../api/lib/purelogin.lib")

#endif // ORACLE|ODBC|PURE

Определение ключа соединения

Для определения ключа соединения в шлюзе BARS Gateway(в библиотеке purelogin.dll) начиная с версии 2.2.1 добавлена функция ResolveConnection(...). Описание интерфейса см. API управления клиентским шлюзомTopic29. Необходимость определения ключа пользователя возникает, например, при авторизации пользователя по ключу. В частном случае механизм может быть использован на сервере приложений или Web-сервере, который сразу после приема соединения от серверного шлюза определяет его IP-адрес и порт и по этим параметрам запрашивает у шлюза идентификатор ключа данного соединения.


Ниже приведена общая схема использования механизма определения идентификатора соединения в упрощенном случае, когда шлюз BARS Gateway запускается как приложение(не как сервис) и его внутренний CORBA-сервер слушает стандартный порт 9999.


Важным является опрос сервера в течении некоторого времени, т.к. на момент запроса данных может не быть, о чем свидетельствует код возврата RESOLVE_LOCK=1.

// ........

// прием соединения

// ....

// определяем хост и порт, с которого это соединение пришло

// и пишем в переменные szHost, nPort

// зовем функцию ResolveConnection(...)

char szKey[32];

size_t nKeySize = sizeof(szKey);

time_t tm_start = time(NULL); 



time_t tm_delta = 0;

time_t tm_max = 5; // ждем 5 секунд
do{


rc = ResolveConnection(szHost, nPort, szKey, nKeySize);


if ( RESOLVE_LOCK==rc ) {

cout<<"Lock detected while trying to resolve connection"<<endl;



::Sleep(10); // спим 10 мсек

}


tm_delta = time(NULL) - tm_start;

}while(RESOLVE_LOCK==rc && tm_delta<tm_max);

if ( RESOLVE_OK==rc )


cout<<"Client Key ID = "<<szKey<<endl;

else


cerr<<"Resolve connection failed with code: "<<rc<<endl;

// в переменной szKey и будет содержаться идентификатор ключа

Пользовательский интерфейс

Client Manager

Окно мониторинга и управления клиентскими соединениями. Ниже представлен типичный вид окна в рабочем состоянии.
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Описание колонок окна.

	Status

	статус клиента Активный/Приостановленный (Active/Suspended).

	ID
	уникальный идентификатор клиента.

	Name
	имя клиента.

	Link description
	описание соединения в формате [адрес клиента] --- [адрес слушателя] ==> [адрес удаленного сервера]

	In Kb
	объем входящих данных(в килобайтах).


	Out Kb
	объем исходящих данных(в килобайтах).



Управление клиентскими соединениями можно осуществлять с помощью кнопок на панели управления или же с помощью комманд меню Manager. 

Описание панели управления клиентскими соединениями.
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	возобновить работу выбранных клиентов(статус Active).
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	приостановить работу выбранных клиентов(статус Suspended).
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	завершить работу выбранных клиентов.


Описание пункта меню Manager.

	Resume Client
	возобновить работу выбранных клиентов(статус Active). 

	Suspend Client
	приостановить работу выбранных клиентов(статус Suspended).

	Terminate Client
	завершить работу выбранных клиентов.

	Terminate All Clients
	завершить работу всех клиентов.

	Refresh Manager
	обновить содержимое окна Client Manager.


Full Log

Окно протокола, содержащее все типы сообщений. Ниже представлен типичный вид окна в рабочем состоянии.
[image: image14.png][ElFull Log =alx|

+13:10:52 { 0} Waiting for connection |
*13:16:50 { 0} Connection accepted

*13:16:50 { 0} Client OLSZEWSK[129.0.0.44:8602] cannected, new id = { 1}

113:16:55  1}1[211/-144] ERR: ACCEPT_ZAH; incorrect input buffer size

*13:16:55 { 1} Main loop finished |
*13:16:55 { 1} Client prepare to disconnect
*13:16:55{ 1} Total In Bytes: 0 Kb
*13:16:55 1} Total Out Bytes: 0 Kb
*13:16:55 { 0} Client { 1} discannected
*+13:18:04 { 0} Connection accenpted






Структура файла протокола и отдельных сообщений описана в разделе Группы сообщенийTopic16.

Errors

Окно протокола, содержащее сообщения об ошибках. Ниже представлен типичный вид окна в рабочем состоянии.

[image: image15.png]X Errors H[=1F3
*13:10:49{ 0} 5 Level 5 log started: DAWOrKBARSG Wisrvgiw log
+13:10:49 { O}# SRVGTW 1.0.1 Nav 20 2000 (C) 2000, Unity-BARS
*13:10:49 { 0} # Config: gateway.cfg

113:16:55  1}1[211/-144] ERR: ACCEPT_ZAH; incorrect input buffer size
113:19:24 { 2} [500/0] CLOSE: Cluse sacket request arrived






Структура файла протокола и отдельных сообщений описана в разделе Группы сообщенийTopic16.

Warnings
Окно протокола, содержащее предупредительные сообщения(например: "Срок действия ключа истекает через 3 дня"). Ниже представлен типичный вид окна в рабочем состоянии.

[image: image16.png]Warnings H[=1F3
*13:10:49{ 0} 5 Level 5 log started: DAWOrKBARSG Wisrvgiw log
+13:10:49 { O}# SRVGTW 1.0.1 Nav 20 2000 (C) 2000, Unity-BARS
*13:10:49 { 0} # Config: gateway.cfg






Структура файла протокола и отдельных сообщений описана в разделе Группы сообщенийTopic16.

Debug
Окно протокола, содержащее текущие и отладочные сообщения. Ниже представлен типичный вид окна в рабочем состоянии.
[image: image17.png]Debu H[=1F3
*13:10:48{ 0} S Level 5 log started: DAWOrKBARSGTWAsrvgtw log
*13:10:48 { 0} # SRVGTW 1.0.1 Nov 20 2000 (C) 2000, Unity-BARS
*13:10:48 { O} # Config: gateway cfg






Структура файла протокола и отдельных сообщений описана в разделе Группы сообщенийTopic16.

API шлюза: заголовочные файлы “C”
API подключаемых модулей протоколирования

/********************************************************************


Filename
:
logapp.h


Description
:
интерфейс подключаемого модуля логгера


Begin

:
08.01.2004


Copyright
:
(C) 2004 Unity-BARS


email

:
bars@unity-bars.com.ua

********************************************************************/

/**

 *
Интерфейс подключаемого модуля логгера вертушки TOSS

 *       и сетевого шлюза BARS Gateway

 *
(C) UNITY-BARS

 *
Модуль может быть собран с любой runtime-библиотекой(single/multithreaded).

 *
Вертушка будет использовать его строго в однопользовательском режиме.

 *
Если библиотека предполагает только однопользовательский режим,

 *
это надо явно указать.

 */

#ifndef  __LOGAPP_H__

#define __LOGAPP_H__

#ifdef LOGAPP_EXPORTS

#
define LOGAPP_API __declspec(dllexport) 

#else

#
define LOGAPP_API __declspec(dllimport) 

#endif

#define LOGAPP_DECL __stdcall

// определение уровней приоритета протокола

#define PRIORITY_ALWAYS

0

#define PRIORITY_ERROR

1

#define PRIORITY_HIGHEST

2

#define PRIORITY_HIGH

3

#define PRIORITY_RECENT

4

#define PRIORITY_COMMIT

5

#define PRIORITY_VERBOSE

6

#define PRIORITY_VV


7

#define PRIORITY_DEBUG

8

#if defined(__cplusplus)

extern "C" {

#endif

/**

 * Возвращает старший номер версии

 * @return старший номер версии

 * @author Группа разработчиков УНИТИ-БАРС 

 * @version 1.0

 */

LOGAPP_API int LOGAPP_DECL GetMajorVersion (void);

/**

 * Возвращает младший номер версии

 * @return младший номер версии

 * @author Группа разработчиков УНИТИ-БАРС 

 * @version 1.0 

 */

LOGAPP_API int LOGAPP_DECL GetMinorVersion (void);

/**

 * Инициализирует подключаемый модуль

 * @param szConfigPath [in] путь к конфигурационному файлу

 * @return 0 - Ok, иначе - код ошибки

 * @author Группа разработчиков УНИТИ-БАРС

 * @version 1.0

 */

LOGAPP_API int LOGAPP_DECL InitAppender (const char* szConfigPath);

/**

 * Деинициализирует подключаемый модуль

 * @return 0 - Ok, иначе - код ошибки

 * @author Группа разработчиков УНИТИ-БАРС

 * @version 1.0

 */

LOGAPP_API int LOGAPP_DECL DeinitAppender (void);

/**

 * Протоколирует сообщение

 * @param nPriority [in] уровень приоритета сообщения, см. константы PRIORITY_*

 * @param szMessage [in] текст сообщения

 * @return 0 - Ok, иначе - код ошибки

 * @author Группа разработчиков УНИТИ-БАРС

 * @version 1.0

 */

LOGAPP_API int LOGAPP_DECL LogMessage (int nPriority, const char* szMessage);

#if defined( __cplusplus )

}

#endif

/*****************************************************************************


Описание типов функций для динамического импорта

*****************************************************************************/

/**

 * Определение типа для функции GetMajorVersion

 */

typedef int (LOGAPP_DECL * TGetMajorVersion) (void);

/**

 * Определение типа для функции GetMinorVersion

 */

typedef int (LOGAPP_DECL * TGetMinorVersion) (void);

/**

 * Определение типа для функции InitAppender

 */

typedef int (LOGAPP_DECL * TInitAppender) (const char* szConfigPath);

/**

 * Определение типа для функции DeinitAppender

 */

typedef int (LOGAPP_DECL * TDeinitAppender) (void);

/**

 * Определение типа для функции LogMessage

 */

typedef int (LOGAPP_DECL * TLogMessage) (int nPriority, const char* szMessage);

//----------------------------------------------------------------------------

#endif
// __LOGAPP_H__

API управления клиентским шлюзом

/********************************************************************


Filename
:
seclogin.h

Version

:   2.2.2


Description
:
клиентская библ. для встроенного криптошлюза


Begin

:
25-03-2002


Modified
:
10-05-2005





В функциях CreateBridge и ResolveConnection для номеров портов возвращен тип unsigned short для сохранения совместимости





05-05-2005





во всех функциях тип short заменен на int





14-04-2005





добавлены функции SetTraceMode(), GetTraceMode(), SetTraceFile() для управления режимом вывода сообщений и трассировкой в файл или на экран в виде диалогов и задания файла трассировки.





06-04-2005





Добавлена функция ResolveConnection для определения ID





ключа соединения по его хосту и порту





28-01-2004





Реализована версия 2.0(полный редизайн)





05-08-2003





Добавлена ф-ция PureLogin(...) для инициализации





без обращения к СУБД


Copyright
:
(C) 2002-2004 UNITY-BARS


email

:
bars@unity-bars.com.ua


dev-email
:
serg@unity-bars.com.ua

********************************************************************/

#ifndef  __SECLOGIN_H__

#define __SECLOGIN_H__

#ifdef SECLOGIN_EXPORTS

#
define SECLOGIN_API __declspec(dllexport)

#else

#
define SECLOGIN_API __declspec(dllimport)

#endif

#define SECLOGIN_DECL __stdcall

// --- БЛОК КОНСТАНТ ---

#define START_APPLICATION
0

#define START_SERVICE
1

#define TRACE_MBOX

0

#define TRACE_FILE          
1

#define RESOLVE_OK

0

#define RESOLVE_LOCK
1

// ---------------------

extern "C"{

/**

 * SetParams устанавливает параметры среды.

 * @param szGatewayPath [in] в случае nStartType==START_APPLICATION укажите путь к barsgtw.exe, если указано значение NULL, делается попытка вычитать путь из реестра по ключу HKEY_LOCAL_MACHINE\SOFTWARE\UnityBars\Gateway\Path. В случае nStartType==START_SERVICE укажите значение NULL.

 * @param szGatewayConfig [in] в случае nStartType==START_APPLICATION путь к файлу настроек gateway.xml, если указано значение NULL, делается попытка вычитать путь из реестра по ключу KEY_LOCAL_MACHINE\SOFTWARE\UnityBars\Gateway\Config. В случае nStartType==START_SERVICE укажите значение NULL.

 * @param nStartType  [in] START_APPLICATION-стартовать как приложение, START_SERVICE-стартовать как сервис

 * @param szCORBADir  [in] служебная директория CORBA (default=C:\BARS)

 * @param nCORBAPort  [in] номер порта сервера CORBA (default=8888)

 * @param szDBAlias   [in] алиас БД (default=NULL)

 * @param szDBKeyUser [in] имя пользователя хранителя ключей (default=keykeeper)

 * @param szDBKeyPwd  [in] пароль пользователя хранителя ключей (default=key123456)

 * @param szDBKeyRole [in] роль пользователя хранителя ключей (default=NULL)

 * @return код ошибки(0-успех)

 */

SECLOGIN_API int SECLOGIN_DECL SetParams (







   const char* szGatewayPath,







   const char* szGatewayConfig,







   int
         nStartType
= START_APPLICATION,







   const char* szCORBADir
= 0,







   int               nCORBAPort
= 0,







   const char* szDBAlias
= 0,







   const char* szDBKeyUser
= 0,







   const char* szDBKeyPwd
= 0,







   const char* szDBKeyRole
= 0







   );

/**

 * SetParams2 устанавливает параметры среды.

 * @param szGatewayPath [in] в случае nStartType==START_APPLICATION укажите путь к barsgtw.exe, если указано значение NULL, делается попытка вычитать путь из реестра по ключу HKEY_LOCAL_MACHINE\SOFTWARE\UnityBars\Gateway\Path. В случае nStartType==START_SERVICE укажите значение NULL.

 * @param szGatewayConfig [in] в случае nStartType==START_APPLICATION путь к файлу настроек gateway.xml, если указано значение NULL, делается попытка вычитать путь из реестра по ключу KEY_LOCAL_MACHINE\SOFTWARE\UnityBars\Gateway\Config. В случае nStartType==START_SERVICE укажите значение NULL.

 * @param nStartType  [in] START_APPLICATION-стартовать как приложение, START_SERVICE-стартовать как сервис
 * @param szCORBADir  [in] служебная директория CORBA (default=C:\BARS)
 * @param szCORBAHost [in] хост CORBA сервера
 * @param nCORBAPort  [in] номер порта сервера CORBA (default=8888)

 * @param szDBAlias   [in] алиас БД (default=NULL)

 * @param szDBKeyUser [in] имя пользователя хранителя ключей (default=keykeeper)

 * @param szDBKeyPwd  [in] пароль пользователя хранителя ключей (default=key123456)

 * @param szDBKeyRole [in] роль пользователя хранителя ключей (default=NULL)

 * @return код ошибки(0-успех)

 */

SECLOGIN_API int SECLOGIN_DECL SetParams2 (







   const char* szGatewayPath,







   const char* szGatewayConfig,







   int
         nStartType
= START_APPLICATION,







   const char* szCORBADir
= 0,
   const char* szCORBAHost
= 0,







   int               nCORBAPort
= 0,







   const char* szDBAlias
= 0,







   const char* szDBKeyUser
= 0,







   const char* szDBKeyPwd
= 0,







   const char* szDBKeyRole
= 0







   );

/**

 * Startup - стартовать криптошлюз (только на локальной машине).

 * При повторном старте функция возвращает положительный результат(т.е. 0).

 * Функцию необходимо вызывать всегда после SetParams().

 * @return код ошибки(0-успех)

 */

SECLOGIN_API int SECLOGIN_DECL Startup ();

/**

 * Shutdown - закрыть криптошлюз

 * Завершать работу шлюза должны только системы обновления математики

 * и то очень аккуратно, чтобы не срубить сук, на котором сидят

 * @return код ошибки
 */

SECLOGIN_API int SECLOGIN_DECL Shutdown ();

/**

 * CreateBridge - создать мост

 * @param szListenerHost [in] хост для прослушивания

 * @param nListenerPort  [in] порт для прослушивания

 * @param szListenerID   [in] ID ключа слушателя или пустая строка

 * @param bListenerAuth  [in] флаг аутентификации слушателя

 * @param bListenerEnc   [in] флаг шифрования слушателя

 * @param szRemoteHost   [in] хост удаленного шлюза

 * @param nRemotePort    [in] порт удаленного шлюза

 * @param szRemoteID     [in] ID ключа удаленного шлюза

 * @param bRemoteAuth    [in] флаг аутентификации удаленного шлюза

 * @param bRemoteEnc     [in] флаг шифрования удаленного шлюза

 * @param pBridgeHandle  [out] handle моста
 * @return 0 - успех, иначе - код ошибки
 */

SECLOGIN_API int SECLOGIN_DECL CreateBridge (


const char*

szListenerHost,  


unsigned short

nListenerPort, 


const char*

szListenerID,


bool


bListenerAuth,  


bool


bListenerEnc,


const char*

szRemoteHost, 


unsigned short

nRemotePort, 


const char*

szRemoteID,


bool


bRemoteAuth, 


bool


bRemoteEnc,


int*


pBridgeHandle

);

/**

 * DestroyBridge - "разрушить" мост (удалить)

 * @param nBridgeHandle [in] handle моста
 * @return 0 - успех, иначе - код ошибки

 */

SECLOGIN_API int SECLOGIN_DECL DestroyBridge (int nBridgeHandle);

/**

 * DestroyAllBridges - "разрушить" все мосты (удалить) 

 * @return 0 - успех, иначе - код ошибки

 */

SECLOGIN_API int SECLOGIN_DECL DestroyAllBridges ();

/**

 * GetLogin возвращает логин и пароль БД для указанного моста

 * (и неявно таким образом ключа слушателя)

 * @param nBridgeHandle [in] handle моста
 * @param nTaskID [in] номер задачи (по-умолчанию 1)

 * @param szDBLogin [out] логин оракла
 * @param szDBPassword [out] пароль оракла
 * @return код ошибки(0-успех)

 */

SECLOGIN_API int SECLOGIN_DECL GetLogin (








int
nBridgeHandle,








int
nTaskID,








char*
szDBLogin,








char*
szDBPassword);

/**

 * GetErrorMsg возвращает описание кода ошибки

 * В данной реализации не используется. Все описания ошибок всплывают в модальных окнах.

 * @param nRes [in] код ошибки

 * @param szBuf [out] буфер для описания ошибки

 * @param nBufSize [in] размер буфера для описания ошибки

 * @return описание кода ошибки
 */

SECLOGIN_API void SECLOGIN_DECL GetErrorMsg (int nRes, char* szBuf, int nBufSize);

/**

 * ResolveConnection - определяет ID ключа(szKey), для соединения с 

 * правой точкой (szHost:nPort)

 * @param szHost    [in]  хост правой точки соединения

 * @param nPort     [in]  порт правой точки соединения

 * @param szKey     [out] ID ключа соединения

 * @param nKeySize  [in]  размер буфера szKey

 * @return 0 - успех, 

 *  1 - обнаружна блокировка во время просмотра списка соединений, 

 *       следует попытаться повторно через некоторое время(н-р, 10 миллисекунд)

 * -1 - ID ключа не найден, -2 - буфер szKey слишком мал, др. ошибки

 */


SECLOGIN_API int SECLOGIN_DECL ResolveConnection ( 


const char* szHost, unsigned short nPort, char* szKey, size_t nKeySize );

/**

 * SetTraceMode устанавливает режим трассировки: 0 - MessageBox, 1 - trace file

 * по-умолчанию 0 - MessageBox

 * @param nTraceMode [in] режим трассировки: 0 - MessageBox, 1 - trace file

 */

SECLOGIN_API void SECLOGIN_DECL SetTraceMode ( int nTraceMode );

/**

 * GetTraceMode возвращает режим трассировки

 * @return режим трассировки: 0 - MessageBox, 1 - trace file

 */

SECLOGIN_API int  SECLOGIN_DECL GetTraceMode ( );

/**

 * SetTraceFile устанавливает файл трассировки

 * по-умолчанию: C:\gateway.trc

 * @param szTraceFile [in] файл трассировки
 */

SECLOGIN_API void SECLOGIN_DECL SetTraceFile ( const char* szTraceFile );

}

#endif // __SECLOGIN_H__
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